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Abstract

A software tool was designed and implemented that leads accident investigators through the
steps of a Systematic Error and Risk Analysis (SERA), a classification scheme based on
Perceptual Control Theory and developed at DRDC Toronto The software presents an
mvestigator with a series of questions about an accident and generates conclusions about the
nature of the failure and its probable pre-conditions. A graphical depiction of the decision
tree allows users to navigate easily among the steps of the analysis At the end of the process,
the software produces a report detailing failures and pre-conditions, and providing equivalent
terminology from the AGA 135 HFACS classification scheme

A help system was developed that makes context-sensitive help available to the user at
various stages of the process In preliminary work to lay a foundation for intelligent aiding,
users’ activities are tracked by the software in a way that can be used in future to provide
intelligent and adaptive help To 1illustrate the potential use of the tracking mechanism, the
software was designed to monitor user actions and offer help whenever there 1s a long delay
without mput

Résumé

On a congu et mis en ceuvre un outil logiciel qui aide les enquéteurs d’accident a exécuter les
étapes d’une analyse systématique des erreurs et du rnisque (SERA), systéme de classification
basé sur les principes du contrdle perceptif et développé par le RDDC Toronto Le logiciel
présente a I'enquéteur une série de questions sur un accident et génére des conclusions sur la
nature de la défaillance et les conditions préalables probables Une représentation graphique
de I’arbre de décision permet aux utilisateurs de naviguer aisément parmi les étapes de
I’analyse A la fin du processus, le logiciel produit un rapport détaillant les défaillances et les

conditions préalables et fournissant la terminologie équivalente du systéme de classification
du SACFH AGA 135

On a développé un systeme d’aide contextuelle auquel I'utilisateur peut avorr recours aux
diverses étapes du processus Au stade préliminaire, en vue d’établir une fondation pour I’aide
intelligente, les activités des utilisateurs sont suivies de prés par le logiciel d’une fagon qui
pourra étre utilisée a I’avenr pour offrir de I'arde intelligente et adaptative A titre
d’1llustration de I'utilisation potentielle du mécamisme de suivie des activités, le logiciel a été
congu pour surveiller les actions de 1'utilisateur et offrir de I’aide lorsqu’il y a un intervalle
prolongé sans entrée
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Executive Summary

A software tool was designed and implemented that leads accident investigators through the
steps of a Systematic Error and Risk Analysis (SERA), a classification scheme developed at
DRDC Toronto That scheme combines Information Processing and Perceptual Control
theories into a model for mvestigating accidents and preventing future recurrences

The SERA tool presents an investigator with a series of questions about an accident and
generates conclusions about the nature of the failure and 1ts probable pre-conditions Users
are able to modify responses to previous questions using a famihar “wizard” interface that
contains choice points with “Next” and “Previous™ buttons Introductory questions require
textual descriptions and are followed by Yes/No questions with areas for adding additional
remarks  Answers to the Yes/No questions determine the user’s path through a decision tree
and result 1n sets of conclusions about active failures and concomitant pre-conditions  If any
conclusion does not agree with the user’s understanding of the situation, SERA 1nitiates a
review of previous answers to help resolve the discrepancy

SERA 1includcs a Flowchart Window with a graphical depiction of its decision tree  The
nodes of the trec are selectable and users can navigate quickly and easily among the steps of
the analysis with a simple click of the mouse Pop-up labels provide brief descriptions of the
nodes and appear whenever the user pauses the cursor over an item  Nodes and links are
coded by colour and shape to indicate their type and a legend appears 1n one comer of the
flowchart window to help users discrimmate among them

At the end of the process, SERA produces a report detailing failures and pre-conditions, and
providing equivalent termimology from the AGA 135 HFACS classification scheme, currently
1in usc by the Canadian Forces Users also have the ability to override the default HFACS
terminology and specify other equivalents In addition to being able to export the report to a
text file, which can be re-formatted easily in a word processor to suit the needs of the user, the
complete file, contaiming all of the interface information, can be saved and returned to 1t at a
later time

A help system was developed that makes context-sensitive help available to the user at
various stages of the process Help screens can be accessed from most windows by clicking
on a question-mark 1con and additional explanations appcar i pop-up windows when the user
pauses the cursor over the description of a failure

In prehminary work to lay a foundation for intelligent aiding, users” activities are tracked by
the software in a way that can be used 1n future to provide adaptive help To 1llustrate the
potential use of the tracking mechanism, the software was designed to monitor user actions
and offcr help whenever there 1s a long delay without input  The activities of the tracking
mcchanism are stored in a log of user actions maintained by the system Future work will
modify those representations in ways that permit more effective intelligent and adaptive
aiding for the SERA user
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SERA was written 1n Java to provide maximum flexibility for future enhancements while
ensuring cross-platform compatibility Versions have been delivered for Windows and
Macintosh platforms, but in future the software could be ported to a vanety of other systems,
including web browsers and handheld devices such as the Palm or PocketPC thereby allowing
investigators to conduct SERA analyses 1n the field

Edwards, J L 2002 Design and Implementation of a Software Tool for Human Factors
Accident Investigation and Classification (PCTACT) AC242, DRDC Toronto CR 2002-168
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Sommaire

On a congu et mis en ceuvre un outil logiciel qui mide les enquéteurs d’accident a exécuter les
étapes d’une analyse systématique des erreurs et du risque (SERA), systeme de classification
basé sur les principes du controle perceptif et développé par le RDDC Toronto Ce systeme
combine les principes du traitement de I’information et du contrdle perceptif dans un modéle
pour enquéter sur les accidents et empécher les récurrences futures

L’outit SERA présente a 1’enquéteur une série de questions sur un accident et géncre des
conclusions sur la nature de la défaillance et les conditions préalables probables Les
utilisateurs peuvent modifier leurs réponses aux questions précédentes au moyen d’une
interface d’assistant familiére qui contient des options avec des boutons Suivant (Next) et
Précédent (Previous) Des questions préliminaires exigent des descriptions texte et sont
suvies de questions de type our/non avec des champs permettant d’entrer des remarques
supplémentaires Les réponses aux questions our/non déterminent le chemin de 'utilisateur
dans un arbre de décision et donnent licu a des ensembles de conclusions au sujet de
défaillances actives et des conditions préalables connexes S1une conclusion donnée ne
concorde pas avec I"interprétation de la situation par 'utilisateur, SERA lance une revue des
réponses antérieures pour aider a résoudre la divergence

SERA comprend une fenétre a ordinogramme avec une représentation graphique de I’arbre de
décision Les nceuds de I’arbre sont sélectionnables, et les utilisateurs peuvent naviguer
rapidement et aisément parmi les étapes de 1’analyse au moyen d’un simple clic de 1a sours
Des étiquettes mstantanées donnent de bréves descriptions des nceuds, et elles apparaissent
lorsque I'utilisateur arréte le curseur sur un nceud Les nceuds et les liens sont a code de
couleur et de forme indiquant leur type, et une légende apparait dans un des coins de la fenétre
a ordinogramme pour aider I'utilisateur a les distinguer les uns des autres

A la fin du processus, SERA produit un rapport détaillant les défaillances et les conditions
préalables et fournissant la terminologie équivalente du systéme de classification du SACFH
AGA 135, actuellement utilisé par les Forces canadiennes De plus, les utilisateurs ont la
possibilité de surpasser la terminologie implicite du SACFH et de spécifier d’autres
équivalents En plus de la possibilité d’exporter le rapport vers un fichier texte, qui peut étre
reformaté aisément dans un traitement de texte selon les besoins de I'utilisateur, le fichier
complet, comprenant toute I'information d’interface, peut étre sauvegardé pour y revenir plus
tard

On a développé un systéme d’aide contextuelle auquel I"utilisateur peut avorr recours aux
diverses étapes du processus On accéde aux écrans d’aide a partir de la plupart des fenétres
en cliquant sur une 1céne a point d’interrogation, et des explications supplémentaires
apparaissent dans des fenétres instantanées lorsque ’utilisateur arréte le curseur sur la
description d’une défaillance

Au stade préliminaire, en vue d’établir une fondation pour 1’aide intelligente, les activités des
utilisateurs sont suivies de prés par le logiciel d’une fagon qui pourra étre utilisée & ’avenir
pour offrir de I’aide adaptative A titre d"illustration de I'utihsation potentielle du mécanisme
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de suivie des activités, le logiciel a ét€ congu pour surveiller les actions de 'utilisateur et
offrir de I’aide lorsqu’il y a un intervalle prolongé sans entrée Les activités du mécanisme de
suivi sont stockées dans un journal des actions utilisateur maintenu par le systéme Les
travaux futurs modifieront ces représentations de fagon a offrir a I’'utillisateur de SERA de
’aide intelligente et adaptative plus efficace.

SERA a été écrit en Java pour offrir une souplesse maximale aux améliorations futures tout en
assurant la compatibilité inter-plates-formes Des versions ont ¢été hivrées pour les plates-
formes Windows et Macintosh, mais a I’avenir le logiciel pourrait étre adapté a une variété
d’autres systemes, y compris les explorateurs Web et des dispositifs portaufs tels que les
ordinateurs de poche Palm ou PocketPC, ce qui permettra aux enquéteurs d’effectuer les
analyses SERA sur le terrain

vi
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Background

Identifying and eliminating factors that lead to accidents 1s essential to preventing future
recurrences Due to advances in equipment reliability, accidents are more likely to be the
result of human error than mechanical error  To facilitate the investigation of human errors, 1t
1s useful to have a systematic process for analysing the causes of faillures and conditions that
lead to those faillures One such system 1s the Perceptual Control Theory Accident
Classification Tool (PCTACT") (Hendy, 2002) Whle other accident mnvestigation tools are
based on descriptive models, SERA 1s grounded in a theoretical approach that combines
Information Processing and Perceptual Control theories (Hendy, East, and Farrell, 2000;
Hendy, Liao, and Milgram, 1997, Powers, 1973) SERA provides

« atool for investigating the human factors causes of accidents and incidents,
- amecans of classifying accidents and incidents, and

« the basis for a risk management tool

To prevent future accidents, their causes need to be identified and steps taken to eliminate the
conditions that led to the errors  Current accident investigation tools, such as the Human
Factors Accident Classification System (HFACS) used by the Canadian Forces Directorate of
Flight Safety, have been developed by analysing factors that contributed to a series of specific
accidents Because they lack a sound theoretical foundation, it 1s difficult to say whether they
model cause and effcct relationships 1n a consistent and reliable manner In contrast, SERA
provides a theorctical basis for identifying cause and effect relations n accident investigations
and 1s subject to checks on consistency and completencss as well as reliabihty and validity

In addition to helping detcrmine the type of failure that occurred, SERA 1dentifies the most
likely pre-conditions that led to the failure These are conditions that would have to be
changed in order to prevent a recurrence of the incident A significant advantage of SERA 1s
that it provides a more comprchensive taxonomy of failures and pre-conditions than existing
accident investigation and classification tools hke HFACS HFACS (Shappell and
Wiegmann, 2000) was developed by analysing a database of spectfic accidents, so there 1s the
nisk that 1ts taxonomy 1s incomplete or redundant due to limitations 1n the data In contrast,
the theorctical underpinnings of the SERA model help ensure the development of a consistent
and complete taxonomy

In order to facihitate the use of the SERA model, a software representation of the system 1s
nceded to provide accident investigators with an efficient way to perform SERA analyses
Such a software tool also would facilitate the collection of data that could help refine the
SERA model itself This project aims to address these 1ssues

' Throughout the rest of this report, the name ot the software will reflect the recent name change of

“Systematic Error and Risk Analysis” and the associated acronym, "SERA.”
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The purpose of this contract will be to design and build a software tool that will lead accident
investigators through the steps of a SERA analysis The software tool will present the
mvestigator with a series of questions and analyse the respondent’s answers in terms of the
source of failure and pre-conditions that led to that farlure In addition to providing standard,
context-sensitive help to the user, the tool will lay a foundation for intelligent aiding and
incorporate one or more examples 1n the final implementation
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Research Approach

Using IP/PCT theory and Hendy’s denived SERA conceptual tool, a comparable software
system was to be designed and implemented The software tool would take a user through a
step-by-step process that characterizes accidents n terms of active failures and their pre-
conditions and would be designed for accident investigators as they gather information 1n the
ficld The principal elements of the program were to be. an easy to use interface, standard
and intelligent help, and, cross-comparisons to similar results from the HFACS tool

The proposed SERA tool would be designed to lead the investigator through a senies of yes or
no questions modelled on Hendy’s flowcharts  These questions would follow decision
ladders which lead to conclusions about the active failures that caused the accident and the
pre-conditions that led to those failures At the conclusion of the question-answering phase,
the SERA tool would present the user with a report detailing the type(s) of failure that led to
the accident and the associated pre-conditions, as well as equivalent terminology from the
Canadian Forces modified AGA 135 HFACS specification

Hclp would be made available to the user at each stage 1n the process For each question
presented, context-sensitive help would be readily accessible including definitions of terms
and descriptions of factors to consider 1n answering the particular question A graphical
overview of the line of questioning was to show where the user 1s 1n the process thereby
providing a better understanding of the overall procedure The software also was to
ncorporate a foundation for intelligent aiding by tracking an investigator’s mterface actions
Among other things, the user interface tracking was to include information about the timing of
the user’s input, allowing the system to offer help to the user when 1t detects a long delay in
answcring a question

Study Objectives and Work Items

The following study objectives and work items were identified for this project:
o To design and build a software tool that will lead accident investigators through the steps
of a SERA analysis The software will have the following features

« A clear, mtuitive interface that presents the user with a series of questions based
on the decision ladders outlined 1n the Hendy’s PCTACT (SERA) technical
rcport

»  Summary conclusions about the nature of the failure and probable pre-conditions
that could have led to that type of failure

« A report detailing these findings

« A revision support function allowing users to modify responses to previous
questions
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Context-sensitive help at each stage of the analysis, with definitions of terms and
other relevant background information presented

To construct a database to accommodate the results of SERA analyses and link the SERA
tool with that database

To provide for cross-comparisons to HFACS terminology

To provide support for intelligent aiding 1n the following forms'

Tracking of user interface actions,
Offering of help when there are excessively long delays without user input,

Offering of help n the face of apparent confusion on the part of the user (e.g
when the user repeatedly returns to modify answers to previous questions),

Possibly incorporating an information-retrieval agent for obtaining up-to-date
information on failures and pre-conditions from the world wide web

€5 v <l iR+ N o s HSOM e PO
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The Main SERA Window

The main SERA window presents information 1n a variety of formats, depending on where the
user 1s in the process These screens include preliminary information on the investigator and
the accident; descriptions and remarks about the unsafe act and the perceptions, goals and
actions of the crew; Yes/No questions, conclusions about failures, candidate pre-conditions;
help, conflict resolution, and report  Following a description of the introductory splash screen
and the nature of navigation within the SERA software tool, detailed descriptions of these
screcns are grven

Splash Screen

This screen appears when the program s first launched and can also be triggered from the
“About SERA” item 1n the Help Menu The window includes the title of the software, the
author and commussioner of the software, and copyright information The accompanying
graphic depicts a CF-18, a Halifax-class frigate and a Coyote personnel cammer (representing
the three services of the Canadian Forces) as well as a maintainer working on a CF-18 The
splash screen can be dismussed by clicking anywhere in the window

Navigation

Navigation among the questions in the SERA analysis 1s accomplished by using “Next” and
“Previous™ buttons which are located 1n the bottom-nght comer of each screen This enables
users 1o easily move among the questions and conclusions in the same familiar manner that
they would navigate in a standard “wizard” interface

The primary benefit of navigating using the “Next” and “Previous” buttons 1s that 1t provides
a sumple way for the user to rcturn to examine prior responses while preserving the state of all
subscquent answers

Users can also navigate by clicking 1items 1n the flowchart window This allows the user to
rapidly move to other locations 1n the decision tree without the need to repeatedly click the
“Next™ and “Previous” buttons (See the “SERA Flowchart Window™ section below )

Each time the user navigates to a new screen, a transition effect, much like those used 1n
PowerPont and other presentation software, 1s used to give a visual cue as to the direction of
the movement 1n the decision tree  Downward motion in the tree 1s conveyed by scrolling the
new screen up from the bottom  Similarly, lateral movements in the tree result in the new
screen scrolling from the night side of the window Box-out transitions are used n situations
where the uscr 1s jumping ahead to a discrete location in the decision tree When the
“Previous” button 1s clicked, the transitions move n the opposite direction A horizontal
blind cffect 1s used when help 1s presented, and the effect 1s reversed when the help 1s
dismussed

et oA et P B Ay A Gt Re P woam t S bRl i€ i sty a1 S E
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Introduction Screen

This screen presents the investigator with a brief description of the software and prompts the

user to enter some basic information This includes the author, the author’s unit, the title of

the report, a brief description of the incident, and the dates and times of both the incident and
the entry of the report  When the program 1is first launched, the report date and time are filled
1n automatically with current values

The user can click on the asterisked(*) “Perceptual Control Theory™ footnote at the bottom,
left-hand corner of this window Doing so brings up a brief description of the theory for
intcrested users

Questions Requiring Textual Responses
There are two types of question 1n the SERA tool those that require textual answers from the
uscr, and those that need a “yes” or “no” response The first four questions 1n the analysis are
of the first type and the remainder fall into the second category The Yes/No question screens
also provide a place to enter textual responses and, for each question, this area 1s appropnately
labelled so as to provide guidance to the user on the nature of the descriptions to be entered
The first four questions requure the user to identify the following

« the unsafe act that led to the accident,

« the crew’s perceptions as they relate to the unsafe act,

« the goals of the crew, and,

« the crew’s actions
Textual answers are entered mnto an editable text area which follows each question A second
text arca allows the entry of any additional remarks the investigator may have These remarks

provide details on the incident being investigated that can be useful to other investigators
reviewing the results

Questions Requiring “Yes” or “No” Responses

The question screens that call for “Yes” or “No™ responses form the backbone of the SERA
decision trees The user’s answers to these questions determine the path through the decision
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tree and thereby result in conclusions about the active failures and concomitant pre-conditions
which led to the accident

In the early stages in the development of this software, the yes or no answers were selected
using radio buttons, which due to their nature had the potential to mislead the user into
thinking one answer was more probable or desirable than another To avoid this problem, a
new 1nterface element was designed using “Yes™ and “No” labels that appear below each
question When a question 1s first displayed, neither item 1s highhighted To provide feedback
to the user that the items are selectable, a faint grey ellipse encircles each item when the
mouse pointer passcs over top When the user selects either “Yes” or “No”, that item 1s
circled in white to indicate the user’s choice

As with the first four questions, there is a text area which permaits the entry of any additional
remarks the user may have In the case of the Yes/No questions, the title of this text area
changes according to the particular question This guides the user to provide specific
information relevant to that question

Conclusion Screens

When the user has answered enough questions for the software to come to a determination
about failures that may have occurred, this information 1s presented 1n a conclusion screen
Each conclusion screen gives the user a list of one, two or three possible failures depending
on the context If none of the conclusions seems appropriate to the user, the following,
addstional choice 1s available “The above conclusion(s) do not fit with my understanding of
the situation ” Selecting this option and clicking the “Next” button takes the user to the
confirmation process, described below

If one of the conclusions does suit the situation, the user selects the associated checkbox to the
left of the description and proceeds to the pre-conditions screen

The user can obtain additional information about a particular conclusion by pausing the
mouse pointer over top of that description A pop-up window appears with a more detailed
description of the farlure  This feature keeps the quantity of text in the window to a mmimum
and eliminates the need to scroll

Pre-Condition Screens

A pre-condition screen appcars after the user has chosen one of the possible failures in a
conclusion window and chicked the “Next” button In the first part of this screen 1s a hist of
the most hkely pre-conditions given the type of failure that occurred  The next section
contains general pre-conditions that could be factors in any type of failure Each item n
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these sections has a Yes or No option next to 1t that can be selected according to whether or
not the user believes that item contributed to the failure

The last question on the screen asks whether the user believes there are other pre-conditions
that may have played a role in the failure If “Yes” is selected then the next screen in the
process will be the “Additional Pre-Conditions™ screen, described below  Otherwise, the
questioning continues at the top of the next branch of the decision tree

Additional Pre-Conditions Screen

This screen 1s invoked when the user indicates from the pre-conditions screen that there are
additional pre-conditions that do not fall into any of the pre-defined SERA categories There
are two text areas, each allowing the entry of an additional pre-condition If there are three or
more to enter, any remaining ones can be typed in the third text area To the nght of each of
these boxces 1s an associated text arca to accommodate an explanation of why the user believes
that pre-condition was a factor 1n the accident

Confirmation Process Screens

The confirmation process 1s undertaken when the user finds that the possible conclusions
offcred by the softwarc are not consistent with his or her understanding of the accident
situation The final choice 1n each conclusion screen 1s checked when the user feels that none
of the conclusions 1s appropriate to the situation  When the associated checkbox 1s selected
and the “Next” button 1s pressed, the software presents the user with a senes of screens
summarizing each question and the user’s answer For each one, “Yes” or “No” can be
pressed to indicate whether the original answer was correct or not The process can be stopped
at any time by clicking the “Cancel” button, whercupon the uscr 1s returned to the conclusion
screen that was displayed before the confirmation process began

If, during the process. the “No’ button 1s pressed, the user 1s returned to that earlier question
so that the answer can be revised Alternatively, 1f all of the questions are answered “Yes”
then the original responses are judged to be correct and the user has the option of re-
examining his or her choice of conclusions, starting over, or exiting the application

Analysis Completion Screen

When the mvestigator has fimished answering all of the questions 1n the decision tree, a screen
1s presented to inform him that the analysis 1s complete At this point, the user has the option
of viewing a report summanzing the findings of the analysis or reviewing the additional pre-
conditions
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View Report Screen

This screen is accessed from the “Analysis Completion™ screen and can also be viewed at any
point n the process by selecting the “View Report” option 1n the “View” menu It presents a
report summarizing the current results of the analysis The contents of this report can be
output to a text file by selecting “Export " 1n the “File” menu

The report 1s divided 1nto three sections corresponding to the three branches of the decision
tree perception, goal (intent) and action Within each section, the user’s responses and the
failures and pre-conditions are listed The questions and answers are rephrased as statements
to facilitate the intcgration of this information into an investigator’s personal report Pre-
conditions are grouped according to whether the user answered “yes,” “no” or neither

Review “Other” Pre-conditions

This screen 1s accessible through a button 1n the “Analysis Completion™ screen It provides a
simple mechanism by which the user can return to the “Additional Pre-conditions”™ screens to
revise or add to those responses This option was incorporated to give the user additional
flexibility 1n the timing of this input
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The SERA Flowchart Window

The flowchart window appears to the night of the main window and gives a graphical
overview of the decision tree It tells users at a glance where they are 1n the process and
where they have been

Node and Link Representations

In the flowchart, questions are represented as blue rectangles Conclusions start out as blue
circles, but when a particular failure 1s 1dentified during the analysis, that circle becomes a red
six-pointed star to facthtate rapid 1dentification of failures in the flowchart Pre-conditions
appear as blue ellipses in this window “Yes™ answers to questions are shown as green links,
and “no” answers appear red to enable the user to quickly see where 1n the decision tree a
particular response will lead

At the start of the process, the shapes 1n the flowchart are drawn only 1n outline  As the user
answers questions, those nodes are filled n, clearly showing the path that the user has
followed The node corresponding to the currently-displayed information 1s drawn with a
bold outline When the uscr returns to a previous node mn the flowchart, the bold outline
moves to reflect the change to the current focus and the shading remains 1n place for all other
answered nodcs to indicate where 1n the tree the user has been

Legend and Labelling

In the upper, left-hand corner of the flowchart window 1s a legend which 1dentifies the various
shapes and colours of the nodes and links 1n the flowchart, and what they represent The three
branches of the decision tree, corresponding to Perception, Goal (Intent) and Action, have
been labelled to further provide context for the user

Sizing and Scalability

The flowchart window 1s scalable to allow the user to expand or contract it according to the
screen space available Restrictions on the minimum size of the window have been imposed
to prevent reducing the window beyond the pont of legibility

10
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Flowchart Navigation and Associated Constraints

In addition to providing a graphical depiction of the user’s location 1n the process, one of the
pnmary purposes of the flowchart window 1s to allow the user to navigate to any point in the
analysis with a click of the mouse button

The user is able to navigate to any screen that has already been visited, corresponding to
nodes that are shaded in the flowchart Additionally, the first question n each of the three
branches of the decision tree can always be clicked This allows the user full flexibility for
beginning the questioning mn any of the three branches Unshaded nodes below these
questions cannot be selected because the software cannot determine a unmique path when the
yes and no questions above have not been answered

11
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Menu Commands

It 1s standard for applications to have at least a “File” menu, an “Edit” menu and a “Help”
mcnu SERA has these, as well as a “View” menu For maximum usability, the menus have
been designed to contain the typical items users expect to see  The remainder of this section
contains descriptions of the various menu 1items for each of the SERA menus

File Menu

The “New” command 1n this menu allows the user to clear all of the current answers and start
over with a blank report

The “Open” command presents the user with a standard file dialog box and will open up a
sclected report that was previously stored using the “Save™ command

The **Save™ menu item stores all of the information that has been entered 1n the current report
n a single file Ths file uses a proprietary file format that is not designed to be human-
rcadable or editable The exact state of the software 1s preserved when this command 1s
invoked

k)

When the user wishes to specify a new name for the file, the “Save As  ” command will

allow this

The “Export  ” command will output a summary of the results of the SERA analysis to a text
file

The “Quit” menu 1tem allows the user to exit the application

Edit Menu

The “Edit” menu items function as they do in most applications These commands allow the
user to mampulate text in the editable text boxes within the software

The “Cut” command deletes the currently selected text and places 1t in the chipboard, while
the “Copy” menu itcm copies it to the clipboard without deleting 1t first The “Paste”
command mserts the contents of the clipboard at the current location of the msertion point
The “Clear” command deletes the text currently selected The “Select AIl” command allows
the user to select all of the text in the text area that 1s currently being edited

12
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View Menu

The “View” menu allows the user to select between two different viewing modes in the
application When the programme s first launched, 1t is in “View Questionnaire” mode
Through the “View” menu the user can toggle to “View Report” mode and back to the
questionnaire This enables the user to examine a summary of the findings at any point in the
process and return to the questions without losing her place

Help Menu
The “About SERA” menu 1tem 1nvokes the SERA splash screen, described previously

The “Page Help™ option brings up a help screen with information relevant to the current
window, 1f such help 1s available

In the Macintosh version of SERA, the system automatically inserts three additional
menu items at the top of the “Help” menu. The first two, “About Balloon Help” and
“Show/Hide Balloons™ are standard Macintosh menu commands available in all
applications. The third item, “Show/Hide Contextual Menus” has no functionality in
this software. These menus do not appear in the Windows version of SERA.

13
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Storage of Textual and Flowchart Data

The software was designed to allow convenient modification of all textual information
presented n the programme  This material 1s stored in a single editable text file, which means
that there is no need to modify programme code 1n order to revise the questions, conclusions,
pre-conditions or help information

Also stored 1n this file is information about the logic of the decision trees and the geometry of
the flowchart This leads to the possibility of modifying not only text, but the sequence of
questions and conclusions, or even the entry of additional questions Some of these changes
could require minor modifications to the programme code, but future versions of the software
could allow full flexibility in this regard

The text file 1s divided into scparate entries corresponding to the various screens in the
software, and they are dehimited by strings of pound (“#”) symbols Each entry contams some
or all of the following information, depending on the type of screen to which 1t corresponds
the text of the question, conclusion, pre-conditions or help, position in the flowchart, title for
the “additional remarks™ arca. and a re-wording of the question in the form of a statement for
entry into the report

14
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File Input and Output

Proprietary File Format to Save and Restore the Current State
The current state of the analysis can be stored at any time using the “Save” or “Save As . ”
command m the “File” menu, and can be retrieved later using the “Open” command in the
same menu This capability makes use of a proprietary file format to store all data that have

been entered by the user  This includes

« answers to the introductory questions (author, unt, title, description, dates and
times),

» textual answers,

- answers to the “yes” or “no” questions,
» conclusion choices,

«  pre-condition information,

« additional remarks

Exporting the Report to a Text File

The report that 1s available to the user at the end of the analysis can be output to a text file
through the use of the “Export ” command 1n the “File” menu A discussion of the format of
this report 1s found under “View Menu” 1n the “Menu Items™ section, above

15
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Standard Help System

There are three components to the standard help system in SERA contextual help 1s available
for specific pages, help windows display detailed information about failures, and there 1s a
single help screen providing background information about perceptual control theory

Contextual help

Contextual help 1s available for all of the question, conclusion and pre-conditions screens
The content of the help 1s derived from Hendy’s PCTACT (SERA) report  As such, 1t mostly
provides general information on the SERA process and lacks specific guidance on the use of
the software Future work on SERA could address this 1ssue

There are two methods of invoking contextual help clicking the question mark 1con 1n the
upper right-hand comer of the window and selecting “Page Help” in the “Help” menu The
help appears using a horizontal blind transition effect It can be dismissed by clicking the
“Return” button, or by clicking anywhere n the window The help imformation 1s dismissed
using a reverse horizontal blind effect If a particular screen lacks a question mark icon, there
1s no help available for that screen

Pop-up Windows Containing Supplementary Information
about Failures

In any of the conclusion screens, the user can pause the cursor over a particular conclusion to
bring up a window containing a more detailed description The cursor must pause for
approximately a second before the help window will appear, to reduce the likelihood that a
user might trigger it unintentionally  When a help window 1s displayed, the user cannot
proceed until this window has been dismissed by clicking anywhere within 1ts boundaries

The descriptions of the failures are taken from Annex B of Hendy’s report  The first sentence
about each failure appears in the main conclusion window and gives a bnief description of that
item This allows the user to view all of the choices without the need to scroll The full text
of the description appcears n the pop-up window, which 1s sized according to the amount of
text to be displayed and positioned to appear below the description in the mam window

Perceptual Control Theory Overview

In the introductory screen the user can click on the asterisked(*) PCT label 1n the lower left-
hand comer to bring up a screen containing a brief overview of Perceptual Control Theory

16
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This feature was added because many users will not have had prior exposure to this theory,
and some understanding of 1t 1s necessary 1n order for users to provide meamingful answers to
the questions in the SERA analysis

17
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Intelligent and Adaptive Help

The goal of the intelligent and adaptive help component of this contract was limited largely to
crcating an infrastructure to track user actions and exploring how that infrastructure could be
used to add adaptive functionality to future versions of the software One simple mechanism
was incorporated in this version but future work could create a more comprehensive help
system Some of these are described in the “Opportunities for Future Enhancements™ section
below

To lay the groundwork for an intelligent and adaptive aiding system, user interface actions are
monitored by the software These include activities such as chcking the mouse on a push-
button, selecting a checkbox, and choosing a “Yes™ or “No” answer The context of the
action 1s also stored, including the interface object involved, where the user 1s 1n the process,
and time-stamp information

Future work could extend interface monitoring to include inference of the user’s goal n
performing a particular action, and making judgements about how that action might fit into a
larger plan  That information could then be used to determine what the user 1s trying to
accomplish and thereby providing the basts for assistance to further that aim  This could
include quertes to validate the user’s intended plan, help descriptions tailored to the pursuit of
that plan and, even automation of select processes 1n the service of the user’s goals

A simple example of a current intelligent help capability 1s the provision for help when there
1s a long dclay without mput from the user The software implicitly infers from this delay that
the uscr may be having trouble deciding how to proceed and therefore should be offered
assistance The system then displays a help dialog box asking 1f help 1s needed and, 1f so,
takes the user to a help page specific to that context

If a user 1s collecting mformation n the ficld, there may be delays as materials are being
gathcred To prevent this help feature from becoming a nuisance to the investigator, these
automatic messages may be disabled by clicking a standard. “Don’t Show Again” checkbox
before dismissing the window

Since the user’s actions are being tracked, there 1s the potential for the system to determine
whether a user has gone back to revise earlier responses  In future, this fact could be used as
an indication that the user 1s experiencing confusion about how to answer the questions, and
the system could offer appropriate help This feature was considered for implementation 1n
the current version of the software, but 1t was detcrmuned that a more fundamental 1ssue
should take precedence, namely resolving conflicts between the system’s conclusions and the
user’s understanding of the accident situation  Consequently, a “confirmation mechanism”™
for resolving those conflicts was designed and implemented as part of the current work

Also considered for the help system was the possibility of incorporating an information
retricval agent  Because the software has been written 1n Java, 1t 1s well suited to the
mtcgration of an agent technology to access the internet  Since the information on the world-
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wide-web 1s constantly changing, there is the potential for retrieving more current information

about failures and pre-conditions than could be obtained using a static help system.

Discussions were held regarding possible designs for such an agent. Prior experience
constructing information-retrieval agents in other contexts would facilitate the design and
implementation of an agent for SERA  Initial work could allow the automated searching of
one or more general Internet search engines A second phase could incorporate the retrieval
of information directly from sites with content that 1s specific to accident investigation

19
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HFACS Equivalents and Database Output

All of the failures and pre-conditions have been associated with equivalents from the AGA
135 HFACS accident investigation system currently used by the Canadian Forces The
category equivalents were derived from Tables 3 through 6 in Hendy’s report  That
information 1s incorporated into the report that SERA produces at the end of each analysis
For each failure and pre-condition, the name of the equivalent HFACS category 1s provided

An onginal goal for this contract was to hink this software with a database of accidents that
have been investigated using the HFACS approach As a consequence of other work on the
project and after discussions with the Scientific Authority, specifications for how that
information 1s to be organised for inclusion into a database and the implementation of that
function were deferred to future contract work

The exported report at the end of the analysis contains all of the information that would be
contained in a database entry 1In future, when a format for the database has been determined,
the software could be modificd to output the report 1n a form suitable to that database

20
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Contract Extension

Upon completion of the first phase of the SERA work it was determined that several features
were mussing from the programme — features that had emerged as essential to the software
but which had not been included among the original work items The contract was extended
to allow for the inclusion of these items, which are descnbed below

Remarks for the Individual Pre-conditions

One fcature the oniginal SERA implementation lacked was the ability to enter remarks for
cach pre-condition This is important because there 1s a need for the investigator to justify
why a particular factor was or was not a precursor to the failure that occurred

In order to avoid interface cluttering, an approach was devised that permitted the use of the
exusting area for typing in comments in the pre-conditions window When the window first
appears, the hcading above that text area indicates the pre-condition to which the remarks
apply, e g, “Additional Remarks for MONITORING AND SUPERVISION ™ As the user
answers yes or no to the remaining questions, the heading changes to indicate that the remarks
apply to that pre-condition and the contents of the text area update accordingly.

HFACS Equivalent Categories

The original implementation of SERA had the capability of generating a report detalling
equivalent HFACS terminology for each conclusion and pre-condition based on the SERA-
HFACS mappings given in tables 3 through 6 of Hendy’s (2002) report This arrangement
gave no flexibility for the mvestigator to taillor HFACS results to the particular accident under
mvestigation As a conscquence, a way was devised to override the suggested equivalents

That capability was incorporated through the addition of an “HFACS” button in the
conclusion and pre-condition windows When selected, the button invokes a new “HFACS
Equivalents” window containing a list of the 24 categories from the AGA 135 HFACS
standard Each item has an associated checkbox and, when the window first opens, Hendy’s
suggested equivalents are pre-selected  The user then has full flexibility to deselect any
dcfault categories that are not suitable and to select other 1iems that are relevant to the
particular conclusion or pre-condition

In the conclusion window, the “HFACS” button 1s dimmed and cannot be selected until the
user has chosen one of the possible failures In the pre-conditions window, answering one of
the “yes™ or “no” questions changes not only the mode of the remarks area, described above,
but also tells the system the pre-condition to which the HFACS equivalents apply
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It is important to note that the same 24 HFACS categories are available for both the
conclustons and pre-conditions Whule 1t is the case that certain HFACS categories are
assoctated with failures and others relate to pre-conditions, Hendy has demonstrated that there
are situations where, for example, a SERA failure will be equivalent to an HFACS pre-
condition It 1s for this reason that all HFACS choices are made available to the user each
time the window 1s invoked, giving the mvestigator maximum flexibility

To complete the implementation of the new HFACS support and the remarks for the
individual pre-conditions, data structures were added to store this extra information
Furthermore, the Save and Open commands were modified to accommodate the additional
data and compatibility with the oniginal file format was maintained so that old data files could
still be opened Lastly, the report output was altered to integrate the new data

Report Output

The format of the report output required modifications, both to accommodate the new
mformation mentioned above and to enhance readability Conclusions were re-organised so
that the type of failure was followed immediately by the HFACS equivalent information,
which in turn was followed by any remarks entcred by the user This format has the
advantage of grouping the information logically instead of presenting it topically, thus
elimimating the need for the user to jump to various parts of the report for related information
The same re-organisation was applied to the pre-conditions

Wordings in the report were also changed to improve readability The descriptions of the
conclusions and pre-conditions were mmmimised to reduce the length of the report and the pre-
conditions were re-worded so that they appear as statements rather than questions

In response to user fecdback on the readability of the report, an extra sentence was added
before each set of pre-conditions answered “No ” The change was made to indicate more
clearly that those are factors that do not contnbute to the accident under investigation The
added sentence reads. “NOTE These pre-conditions ARE NOT considered to be
contributory ™
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Implementation Platforms

Candidate implementation software were C and Java running on Microsoft Windows
platforms Although the SERA tool could be developed using a wide vaniety of other
softwarc languages, ¢ g, Visual Basic, it was decided that the use of C or Java would allow
greater flexibility for future enhancements Both languages allow for portability to other
hardware platforms and integration with software agents The use of Java permits
umplementation as both a stand-alone application and as an applet accessed via the world-
wide-web and executed in a web browser

Java was chosen for this implementation because 1t 1s the more portable of the two languages,
thus providing the most flexibility for future Intcrnet capabilities The Windows
compatibility enables the software to run on the majority of laptop computers, thus giving
greater scope for use 1n the field

The first phase of SERA development took place on the Macintosh using Metrowerks
CodeWarrior software It was then ported to the Windows platform using Metrowerks for the
PC Ascxpected, modifications to the Java programme were necessary due to differences in
the behaviour of the two operating systems  Contract extension work followed a similar path
of intial development on the Macintosh and a subsequent port to Windows on the PC
Versions for both platforms arc now available

The flexibility of Java 1s unmistakable Due to 1ts portability, there is the potential 1n future to
produce versions of SERA that would run on Sun Solaris systems, UNIX/LINUX boxes,
Windows CE and other PDAs, and even 1n browsers over the web
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Opportunities for Future Enhancements

Future work on the software could encompass some or all of the following items

Add support for stylised text

This would enable bold, 1talic and underlined text to be used n the questions, conclusions and
help descriptions

Implement an automatic save mechanism

This could be designed to automatically save a backup file periodically while the investigator
1s conducting an analysis In the event of a system crash, most tf not all of the entered
mformation could be recovered from this file the next time the application was launched,
much as it 1s handled 1n Microsoft Word, for example

Implement a Palm or PocketPC version

This would allow a user to perform a SERA analysis n the field using a PDA or other
handheld device

Create a web site implementation

Because the software has been written 1n Java, much of the interface could be adapted for use
on a web site with mimimal modifications to the programme code  One major area that would
need to be redesigned would be the storage of the report at the end of the analysis This 1s due
to sccurity restrictions imposed 1n Java that prevent programmes that are running n a web
browser from accessing a user’s local hard drive

Incorporate risk management analysis

Hendy s report discusses methods for applying the perceptual control theory to risk
management assessments These techniques could be incorporated into a future release of the
SERA software
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Validate the theory

A study could be done to systematically compare the results of SERA analyses with those of
an established accident classification tool such as HFACS Statistical analysis could shed
light on the efficacy of the SERA approach

Create pop-up labels in the flowchart window

This would provide pop-up description labels i the flowchart window when the user paused
the mouse pointer over a particular node

Expand the contextual help materials

The matcrial 1n the contextual help system would benefit from revisions and additions The
current help has general information about the SERA process, but lacks specific material on
the features and use of the software tool One or more “instructions” screens could be added,
as well as more detailed descriptions of the mdividual pre-conditions

Extend the tracking capabilities

The help system could be extended to allow more elaborate tracking of user actions In the
current version of the software, certain interface actions are not monitored, such as
repositioning windows or moving the mouse over a “Yes” or “No” button causing 1t to be
highlighted This information could be incorporated into a model of the user

Intelligent Adaptive Aiding

Future work on the help system could incorporate a user model that would mantain a
database of different uscrs, their habits and preferences The system could draw inferences
about a user’s capabilitics and knowledge based on that information, and the results of such
inferences could provide a basis for adaptive interfacing  For example, 1f the system
determincd that a user had a large amount of experience with the software, the descriptions of
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failures and pre-conditions could be shortened thereby simplifying the display and reducing
the need for scrolling  On the other hand, if the user was a comparative novice the system
could provide detailed descriptions and additional nstructions  Such knowledge of a user’s
proficiency could determine the level of help to offer in other contexts

One other useful form of mtelligent help to the SERA user would involve comparing the
results of the analysis with previous results to 1dentify similarities This “case-based”
approach could be accomplished through pattern-matching in the database of previous reports
By drawing the user’s attention to other reports where the same or similar types of failure
have occurred, the investigator might discover valuable insights in the factors that other users
have considered in similar accident situations

Another future enhancement could provide help to the user when an action is performed that
has no effect  Examplcs of this type of action include

« chcking the dimmed “Next” button when neither “Yes” nor “No” has been
selected 1n a question screen, or

« clicking a node 1n the flowchart that has not yct been visited and not at the top of
one of the three branches

The system could detect these actions and provide information detaihing why they had no
effect
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Collage.jpg
» This image file contains the collage that is displayed on the splash screen.

Dialogs.java
» This file contains the Java code for the dialogue boxes, including the HFACS
window, the help prompt, the pop-up help windows and the “save changes”
prompt.

Flowchart.java
* This file contains the Java code necessary for the SERA Flowchart window.

Main.java
* This file contains the Java code that serves as the main entry point when the
application is launched.

MainWindow.java
* This file contains the Java code necessary for the main SERA window.

SERA.mcp
* This is the Metrowerks CodeWarrior project file.

Title.jpg
* This image file contains the graphic of the SERA title that is displayed above the
collage on the splash screen and at the top of all subsequent screens.

Tree.txt

* This file contains the text of questions, conclusions and pre-conditions, as well
as information on the relationships among the nodes in the SERA decision tree.

31



P518636.PDF [Page: 45 of 47]

DOCUMENT CONTROL DATA SHEET

1a. PERFORMING AGENCY

2. SECURITY

Artificial Intelligence Management and Development Corporation, | CLASSIFICATION

206 Keewatin Avenue, Toronto, ON M4P 1Z8 CANADA

1b. PUBLISHING AGENCY
DRDC Toronto

UNCLASSIFIED
- Unlimited distnibution -

3. TITLE

(U) Design and Implementation of a Software Tool for Human Factors Investigation and Classification

(PCTACT)

4. AUTHORS
Jack L Edwards

S. DATE OF PUBLICATION

August 31, 2002

6. NO. OF PAGES

41

7. DESCRIPTIVE NOTES

8. SPONSORSHIP/MONITORING/CONTRACTING/ASKING AGENCY

Sponsoring Agency

Monttoring Agency

Contracting Agency DRDC Toronto
Tasking Agency

9. ORIGINATOR'S DOCUMENT NO.

Contract Report CR 2002-168

10. CONTRACT, GRANT AND/OR 11. OTHER
PROJECT NO. DOCUMENT NOS.

PWGSC W7711-01-7763/001/TOR, AC242
131111

12. DOCUMENT RELEASABILITY

Unlimited announcement

13. DOCUMENT ANNOUNCEMENT

Unlimited announcement

v e s e ——e. e



P518636.PDF [Page: 46 of 47]

14. ABSTRACT

A software tool was designed and implemented that leads accident investigators through the steps of a
} Systematic Error and Risk Analysis (SERA), a classification scheme based on Perceptual Control Theory
l and developed at DRDC Toronto The software presents an investigator with a senies of questions about
an accident and generates conclusions about the nature of the failure and its probable pre-conditions A
graphical depiction of the decision tree allows users to navigate easily among the steps of the analysis At
the end of the process, the software produces a report detailing failures and pre-conditions, and providing
equivalent terminology from the AGA 135 HFACS classification scheme

I A help system was developed that makes context-sensitive help available to the user at various stages of
the process In preliminary work to lay a foundation for intelligent aiding, users’ activities are tracked by
the software 1n a way that can be used 1n future to provide intelhgent and adaptive help To illustrate the
potential use of the tracking mechanism, the software was designed to monitor user actions and offer help
whenever there is a long delay without input

RESUME

On a congu et mis en ceuvre un outil logiciel qui aide les enquéteurs d’accident a exécuter les étapes d’une

analyse systématique des erreurs et du nisque (SERA), systéme de classification basé sur les principes du
i controle perceptif et développé par le RDDC Toronto Le logiciel présente a I’enquéteur une série de
I questions sur un accident et génére des conclusions sur la nature de la défaillance et les conditions
préalables probables Une représentation graphique de I’arbre de déciston permet aux utilisateurs de
naviguer aisément parmui les étapes de I'analyse Alafin du processus, le logtciel produit un rapport
détaillant les défaillances et les conditions préalables et fournissant la terminologie équivalente du
systeme de classtfication du SAC™ ACA 13"

On a développé un systéme d’aide contextuelle &' ,ucr * ¢ peut avorr recours aux diverses étapes
du processus Au stade »riliminaire  2n vue d’etablir une fondation pour I’aide intelligente, les activités
des utilisateurs sont swivie. 2 pi- ~orle kogioic! d -me fagon qui pourra étre utihsée a I’avenir pour offrir
de I’aide intelligente et adaptative A i .i¢ .5 . on de 'utihsation potentielle du mécamsme de sutvie
des activités, le logiciel a été cor... pow. .. s actions de 'utilisateur et offrir de 1'aide lorsqu’il y
a un ntervalle prolongé sans e.n1/' =
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(U) HUMAN ENGINEERING TOOLS, HUMAiIv FACTORS ENGINEERING, SYSTEMATIC ERROR
I AND RISK ANALYSIS TOOL, SERA
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